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The MakerBit Media Linker 
 
Now that you’ve got the sensors and LED working, let’s connect your project to the 
computer, and use the MakerBit Media Linker to play a video when the sensors are 
touched, and also to turn on and off the LED under the command of the computer, so 
that the LED will stay on even when you’re not touching the sensors, and properly turn 
off when other sensors are touched. 
 
The MakerBit Media Linker is an app for the Chrome browser that can connect 
related YouTube or Google Drive videos (even ones you create yourself) and 
other digital media to your project.  If you haven’t installed it yet, click here for 
instructions on how to install the MakerBit Media Linker and put the MakerBit program 
on your micro:bit. 
 
To start, connect the MakerBit to your Chromebook, Mac or Windows device with the 
USB cable, and then open the MakerBit Media Linker.  
 
The oval at the upper-right corner of the window should turn green, and display, “Now: 
Active”. 
 

 
 
If it’s not green, and instead displays “Now: Idle” in red, use the serial port choice in the 
Settings menu to set the serial port to the MakerBit.  If that doesn’t connect to the 
MakerBit and change the oval to green, click here to reset the serial connection for the 
MakerBit and USB cable. 
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Media Lists 
  
The MakerBit has two modes of operation. If it is not connected to a computer, or if 
the computer is not actively communicating with it (the “automatic mode”), touching a 
touchpoint (numbered 5 through 16) turns on the corresponding LED (also numbered 5 
through 16). 
 
When the MakerBit device is actively communicating with the MakerBit Media 
Linker, then this automatic mode is turned off, and it waits for commands from 
the MakerBit Media Linker to turn on and off the LEDs. 
 
Controlling LEDs and responding to touch sensors is structured around lists, called 
media lists, of YouTube or Google Drive videos or other web-based media. The media 
list lets you specify which video to play when a touch sensor is touched.  
 
It also works in the other direction: you can specify which LED to turn on and off during 
a YouTube or Google drive video. 
 
Overview of the MakerBit Media Linker 

 
(http://makerbit.com/resources/Media%20Linker%20Overview.png) 
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To use the Media Linker, you use the right-hand window (the “web-view”) to search for 
and select Internet-based media. 
 
When you have the digital media you want in the web-view window, then you click on 
the green “+” icon in the left-hand window (the media list) to add it as a media list item. 
 
Once added, you click on the blue triangle to open the configuration window. This is 
where you set which touch sensor will play a video or display a web-page. You can also 
set which LEDs will turn on and off when that digital media is actively displayed. 
 
 

You use a media list with videos or other digital media to create the 
“programming” for an interactive maker project. 

 
Important Ideas: 

 
One touch sensor can start one video (or display any page 

on the Internet) with one media list item. 
 

A video playing can turn on/off one or more LEDs during 
specified time ranges by using one or more media list items. 

 
Media lists don’t “play” in their order in the list. Each 

individual media list item responds whenever a sensor is 
touched, or a video is at a defined time (or the defined 

webpage is in view). 
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Creating a New Media List 
 
Creating a new media list is easy: Just choose New Media List from the File menu: 
 

 
 
Media list name: If you click on “Untitled”, you can enter a new name for your media 
list.  You can also edit and change this any time in the future that this media list is open. 
 

 
 
For this practice media list, give it a name like “First media list”, or any other name 
that you like.  
 
Go to the address bar in the web-view window on the right and click on the 
volcano icon to open a sample YouTube video, “Volcano Parts”, in the web-view 
window.  
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The MakerBit Media Linker supports many different kinds of web content: “regular” 
webpages (which includes Google Slides), YouTube videos, and Google Drive videos. 
 
If you don’t have YouTube access, click the camera (Google drive videos) icon in the 
menu bar of the web-view window.   The MakerBit sample files include the “Parts of a 
Volcano.mp4” file. 
 

 
Choose the Parts of a Volcano video.  (Note, if for some reason the Parts of a Volcano. 
Mp4 file is not present, you can click  this link (https://goo.gl/K7X9aj) to open the video 
video in your browser, and then save it to your own Google drive. 
 
 
With the video that you want to add visible in the web-view window, click the add 

media  icon, and you’ll be presented with a window where you can enter exactly the 
Start and End times of that video that you wish to play. 
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If you don’t have YouTube access, click the “Google Drive” icon in the menu bar of the 
web-view window, and choose the Parts of a Volcano video that you added to your 
Google drive just a moment ago from this link. 
 
For YouTube videos, the Start time is auto-filled with whatever time the video was at 

when you used the add media icon. Edit the “Sec.” (Seconds) box to be “0”, for 
the start of the video. The End time defaults to the normal end of the video. For 
Google drive videos the Start will always default to “0”.  
 

 
 
Click on “Convert to Safe YouTube Video”.  This will link to an alternate playback page 
that skips YouTube advertisements, and the “suggestions” at the end of a video.  This 
option is not available or needed for Google Drive videos. 
 
Click the OK button to accept the Start and End times. 
 

8 

https://goo.gl/K7X9aj


 

You have now added the first media list entry for your video. Let’s see how to set it up to 
have it play when you touch sensor #8. 
 

 
 
Click the blue triangle to expand the controls of the first entry in the media list. 
 

 
 
This media list item represents the digital media that will be associated with a touch 
sensor. At the moment, it is not set up to start when a sensor is touched, and it does not 
turn on any LEDs. The checkboxes for each of the three configuration windows (Input to 
Respond to, Arriving at Media, End of Media) are not checked, and the lines for the 
touch sensors and LEDs are gray. 
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To tell it to respond to a sensor, check the “Input to Respond to” checkbox on the left to 
activate the “Respond to” window. 
 

 
 
You can now clearly see the list of touchpoints, starting with touchpoint number 5. 
 
The Mode column indicates which mode of a pin is being monitored.  If the pin doesn’t 
have a check-mark, then Mode and Respond display “ignore”.  This will change in a 
moment when you set the checkmark for pin 8. 
 
The “Now is” column shows the status of all the touchpoints in real time. If you touch 
touchpoint number T8 (which should be next to “Start video” on the tri-fold), the “Now is” 
display will change to “Touch”. 
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Note: If the “Now is:” column is gray and/or blank, check to make sure that the 
touch sensor cable is attached to the gray (not blue) box connector. If it is 
connected correctly, but the column is gray or blank, you should try the USB 
reset procedure to re-establish the connection to the MakerBit. 

 
To tell the MakerBit Media Linker to watch for sensor T8 being touched, click on the 
checkbox for “T8”.  The “Mode” at the bottom of the list will automatically change from 
“Ignore” to “Touch”.  When you touch sensor T8, the “Input to Respond to” box will turn 
green, and the YouTube or Google drive video will play. (try it now) 
 

 
 
The Mode pop-up allows you to override the default “Touch” condition in case there is a 
situation where you deliberately want to respond to a sensor not being touched, but that 
would be very unusual, so generally you can just leave this on the automatic setting of 
“Touch”. You can also use the “label” field to give names to the sensors, like “start 
video”. 
 
That’s it! To set up playing any video, open the configuration window for any video that 
you’ve added to the media list, and check the box for the touch sensor that you want to 
start that video. 
 
Now let’s add media list items for different parts of the volcano.  To add the next media 
list item, click on the green “+” icon with what is now the Safe YouTube Volcano video 
still present in the web-view window. 
 
This time, set the beginning and ending times to 0:10 and 0:12 

11 

https://docs.google.com/document/d/1Eo4rS7j8_NLSRiJiA5PWvXvq5BPp_rjGgvqhFevNalI/edit#bookmark=id.t26rxrp35fw3
https://docs.google.com/document/d/1Eo4rS7j8_NLSRiJiA5PWvXvq5BPp_rjGgvqhFevNalI/edit#bookmark=id.t26rxrp35fw3


 

 

 
 

Now click on the blue triangle for the 2nd media list item to open up the configuration 
window. 
 
The boxes “Arriving at Media” and “End of Media” are used to configure which LED 
number to turn on and off. 
 
Click on the check-boxes for “Arriving at Media” and “Leaving Media”, and click on the 
check-boxes for Pin 5 in both windows.  They’re labeled “Pin” to be consistent with 
usual micro:bit naming conventions, but in this case, they will connect to LED number 5. 
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This tells the MakerBit Media Linker to do turn on LED 5 at the beginning 10 seconds 
into the video, and then turn it off when the display reaches the end of that short 
segment.  
 
Notice that the “Mode” setting automatically is set to “Output: High”, which in a digital 
circuit with an LED will turn on the LED.  If for some reason you did want to turn off an 
LED when a video started, you would change the setting to “Low”. 
 

 
 

You can test the LED control with each of the Test buttons. 
 
What you have now set up are two media list items, the first of which says to play the 
entire video when touch sensor T8 is touched and released (do remember to touch 
AND release), and the second media list item turns on LED 5 when the video is at 
0:10 seconds, and turns it off when the video leaves the end of the video, 0:12. 
 
Try it now by touching your sensor for “Touch here”. 
 
What you should observe is that when you touch and release sensor T8 on the tri-fold, 
the video starts and during the video LED 5 turns on when the student says “main vent”, 
and then turns back off. 
 
Touching the sensor T5 for the 2nd media list item doesn’t do anything yet, because 
you haven’t yet configured the media list item for a touch input. 
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If you haven’t already, now would be a good time to name your media list, and save it 
with “Save Media List” in the File menu. 
 

 
 
 
Configure for a touch in the media list item 
 
With the configuration for media list item 2 still visible click the checkbox “Input to 
Respond to” box, and then check the box for T5. 
 

 
 
Try out your completed media list now by touching sensor T8 to start the video and 
touching T5 to play just the “main vent” section. 
 
Now repeat what you’ve learned to add two more media list items, one for the video 
from 0:12 to 0:14 seconds, and setting touch sensor T6 and LED 6 for the “secondary 
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vent”, and the other for the video from 0:16.7 to 0:17.5 with touch sensor T7 and LED 7 
for the “crater”. 
 

 
 

 
 
Now try out the model! 
 
When you touch the “start video” sensor (#8), the entire video will play, and the LEDs 
for the main vent, secondary vent and crater will turn on and off at the appropriate 
times. 
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If you touch sensors 5, 6 and 7 on the tri-fold, the video will just play the part of the 
video where the student is saying the name of those parts, and the LEDs will briefly turn 
on, and then off. 
Note that the MakerBit Media Linker automatically displays the touch sensor 
inputs in gray if the the touch sensor rainbow cable is not attached to the board, 
or if the USB serial is not operating properly, or if the MakerBit board is not connected to 
the computer with the USB cable. 
 
You can still configure inputs and LEDs when the MakerBit (or the rainbow cable) is not 
attached. The gray display is just there to alert you to the fact that there is not currently 
an active connection to either the MakerBit board or the touch sensors. 
 

       
 

     Rainbow cable attached,  Rainbow cable not attached, or, 
     Working USB connection          USB not connected 

 
Note that only .mp4 videos less than 25mb in size can be played back by the MakerBit 
Media Linker. If you upload other video file types to your Google Drive, for example 
.mov files from an iPhone or Mac, they will have to be converted to .mp4 to play back in 
the MakerBit Media Linker.  The Handbrake video converter works well for this. 
 
 
What You’ve Learned 
 
You have now learned how to set up a sensor to play both an entire video, or just part of 
a video. 
 
You’ve also learned how to turn on and off an LED during a particular part of a video. 
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These are the key concepts for any MakerBit interactive maker project: 
 
One touch sensor can start one video (or display anything on 

the Internet) with one media list item. 
 

A video playing can turn on/off one or more LEDs during 
specified time ranges by using one or more media list items. 

 
 
By understanding these two ideas, you can enhance any type of physical project 
with your own digital media that explains and interacts with a physical mode. 
 
The following sections are additional helpful information, but you have now completed 
the main purpose of this tutorial. 
 
Congratulations! 
 
Continuing Your Learning: Coding with the MakerBit 
 
The MakerBit system is designed to enable limitless continued learning. As just 
one example, if you would like to learn about coding to create your own programs 
for the MakerBit, click here to learn more about Coding with the MakerBit. 
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Saving Media Lists 
 
Media lists that have a name other than “Untitled” are automatically periodically saved 
to your Google Drive, where they are stored in a folder named “makerbit”. 
 

 
 
There is a menu item Save Media List that you can use any time that you wish to 
manually save your media list file.  
 

 
 

 
It’s a good idea to always manually choose “Save Media List” before you quit the 
MakerBit Media Linker when you you’ve been making changes to your media list. 
 
 
IMPORTANT NOTE ABOUT MEDIA LISTS AND GOOGLE DRIVE 
 
When you are working with your Chromebook, and if you have more than one Google 
account, for example school and personal, you need to be aware that the Chrome 
browser login, the account the chrome web browser is signed into, is not necessarily the 
same as the Chromebook login.  
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MakerBit Media Linker and the other Google apps will use the Chrome browser 
login, not the Chromebook device login. To identify the Chrome browser login, look 
at the title bar of the MakerBit Media Linker. you should see a small menu titled with the 
browser username. 
 

 
 
The account name that you see at the upper-right corner is the account that the 
MakerBit Media Linker will use to create and access the folder on Google Drive named 
“makerbit”, where the media lists are stored. 
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Linking Videos and Other Digital Media 
 
In the MakerBit Media Linker there are two windows. On the left is the media list, and 
on the right is a reduced view of a browser window called the “web view” window. 
 

 
 

“+” button - Add a video or webpage: When you click the  symbol, it will grab 
the URL of whatever webpage or video is being viewed in the web-view window of the 
MakerBit Media Linker at that moment and make that the media list item target URL. 
 
You must have the video or other digital media visible in the web-view window 
that you want when you add to your media list (except for Google drive videos) 
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Controlling LEDs 
 
Turning on and off an LED during a video is also done with a media list item. 
 

 
 
It is not necessary to have a touch sensor set up for every media list item.  In the 
illustration above, LED 5 will turn on when the video reaches 0:10 seconds, and 
will turn off at 0:12. 
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Sharing Media Lists  
 
There are these easy ways to share a media list with another person: 
 

1. Share a link to your media list. If you look at your media list inside the 
‘MakerBit’ folder on your Google Drive, you can Control-click (right-click) on it to 
get a list of options that include “get link”. 

 

 
 

When you send that link to someone, they just copy/paste it using Import media 
list: 

 

    
 

2. Share the media list itself. Use the same technique as above for locating your 
media list in the MakerBit folder on your Google Drive. Instead of choosing “Get 
Link”, choose “Share…” and add the other person’s gmail address to those the 
can view the media list. Be careful to share it as “view only” so that they don’t 
accidentally make changes to your file. If you only allow them to View your media 
list, then they will have to make their own copy to be able to save changes. 
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3. Download the media list from your own Google Drive, and email the media list 
itself to the other person. When they receive it, they will need to put the file in 
their Google Drive by uploading, which is as easy as drag-and-drop to their 
MakerBit folder in their MyDrive folder. 
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Media List Options 
 
Here is a list of the available options in the media lists window. 
 

“+” icon - Add a link to digital media: When you click the  symbol, it will grab 
the URL of whatever the currently active webpage or video is being viewed in the web 
view window of the MakerBit Media Linker at that moment. The only exception to that is 
for Google Drive videos, where the “+” icon will then show you a gallery of all of your 
Google drive videos from which you can select one. 
 
The URL box - Your Media Content: Once you have added a URL to the media list, it 
will look like this example item in the list: 
 

 
 
When you choose to add either a YouTube or Google Drive video, you’ll be presented 
with a window where you can enter exactly the START and END times of that video that 
you wish to play. 
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The Start time is auto-filled with whatever time you were at in the video when you 

pressed the icon. The End time defaults to the normal end of the video.  
 
Media List Items Can Have Names 
 
When you have a lot of different media list items for the same video, it’s not easy to tell 
which one is relevant to a particular part of the video. 
 
You can give each media list item its own name.  Just click on the item and enter a 
descriptive name for that item. 
 
 
IMPORTANT: Google Drive videos must be less than 25mb in size and set up as 
“shared” set to “anyone with link can view”. This is still semi-private, but it’s 
required for the MakerBit Media Linker to be able to access the video.  
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Linking videos is the easiest and most direct way to create the digital informational 
content that will accompany your project.  However, you can also set things up so that 
touching a sensor opens a Wikipedia page, or displays an exact position in Google 
maps, as just a few examples. 
 
Note that only .mp4 videos can be played back by the MakerBit Media Linker.  If 
you upload other video file types to your Google Drive, such as .mov files from an 
iPhone or Mac, they will have to be converted to .mp4 to play back in the MakerBit 
Media Linker. 
 

 
 
To convert a video from .mov or other format to .mp4, one way is to upload it to 
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YouTube (you'll probably want to set privacy to 'private' or 'unlisted'), and then use the 
"Download as .mp4" option in Studio Creator.  Another way is to use a utility such as 
“Handbrake” to convert the video.  
 

If you press the icon for a URL entry in the media list that already has information, it 
will ask you if you want to replace the existing URL. Since this only replaces the URL 
and does not change the MakerBit control settings (discussed later), this can be a fast 
and useful way to re-program an existing media list to a new video or set of webpages. 
 

 Green Play icon:  Clicking this will tell the Chrome browser to go to the URL. If the 
URL is a video, then it will play just the part of the video that you’ve specified with the 
Start and End times. 
 

 Settings (gear) icon: When you click the "gear" icon for an item in the media list, 
you will get a window of options for that media type. 
 
For a video, you can edit the Start and End times of the video.  
 
For a webpage, you have the options of editing the title (name) of that item in the media 
list, and also the URL that will be used for that item. 
 
Editing the name is very useful. Each media list item can be renamed to reflect its actual 
content or purpose in your list, not just the webpage name. 
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You should use caution when editing the URL, because the MakerBit Media Linker does 
not check to see if a URL is valid. That is, whether it goes to an actual existing website 
or not. 
 
 

Expand to See MakerBit Controls icon: Clicking this icon opens a window below 
the URL entry in the media list to display the three MakerBit options for any URL, 
whether that be a video, a web-page, or any other web information that has a specific 
URL associated with it. 
 

 
 
 
The three controls are: 
 
Input to Respond to: When the MakerBit Media Linker detects a condition on the 
MakerBit board inputs, such as a touch, it will force the browser to go to that URL in the 
media list. 
 
Start of Media: When the browser arrives at the URL in the media list, or is at the Start 
time for a video clip, then the MakerBit Media Linker will set the pins of the MakerBit 
board according to what is configured in the middle panel (“Start of Media”).  In the 
above illustration, arriving at the Start (time = 00:00) of the Google Drive video named 
“Volcano Movie.mp4” will set pin 13 to HIGH, which will turn on an LED connected to 
pin 13. 
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End of Media: When the browser leaves the URL in the media list, or is at the end of a 
video clip, then the MakerBit Media Linker will set the pins of the MakerBit board 
according to what is configured in the right-most panel (“End of Media”).  
 
Sensors and LEDs (pins) Can Have Names 
 
You can also assign a name to individual sensors and LEDs in your media list that 
correspond to their function in a model. 
 
To give a sensor or LED (pin) a name, click on that item in the configuration window, 
and then edit the name “untitled” to be whatever name you wish for that sensor or LED 
(pin).  
 

 
 
When you name a sensor or LED anywhere in the list, that same name then shows up 
properly in the configuration window of any other item in the media list. 
 
Programs - Alternate Behaviors for the MakerBit 
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 The Data View 
  
The View menu of the MakerBit Media Linker has 2 options, “media list” and “Data” 
 

 
 
The default mode is the media list, which has been described above. 
 
The Data View is where you can get a visual display of all MakerBit analog input values, 
and you can manually set any MakerBit pin you wish. This is modeled on the program 
Firmata Test for the Arduino, where the Arduino is running Standard Firmata.   
 

 
 
 
With the Data View, you can set any pin to input or output, servo or PWM, depending on 
whether that pin supports that mode.  
 
If you check the box to select an analog input, the value (0-1023) will be displayed on 
the graph with a selectable time-base.  You can also change the Y-axis to be 0-1023, 
0-255, or 0-5v. 
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Changing the timebase changes the amount of time marked off by each vertical line on 
the X-axis. 
 
 
The Help menu - Download Log 
 

 
 
This is an option for diagnosing problems that may come up during the use of the 
MakerBit Media Linker.  Choosing this downloads a text file of a log of operational 
events of the MakerBit Media Linker.  This can then be emailed to tech support for 
further assistance. 
 
 
Going Further with the MakerBit 
 
The MakerBit is really just a simple bridge between the physical and digital worlds.  It 
makes connections easy, and readily accepts programming from a wide variety of 
different programming environments. 
 
Click here to go to a document with quite a number of different activities that will teach 
you about different media types that can be used in your projects, and also introductions 
to coding with MakeCode. 
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